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1. Getting Started

1.1 About GMG ColorServer Quick Start Guide

The Quick Start Guide is an easy-to-understand approach to getting started with GMG ColorServer, illus-
trating the hotfolder based processing of PDFs for conventional print methods.

In this tutorial, you will learn to do the following:

Install the program

Create a new PDF hotfolder for automated PDF processing

Create a manual PDF job

Just follow the instructions step by step.

1.2 Welcome to GMG ColorServer

GMG ColorServer is a versatile program for a broad range of color management applications.

Customized software packages and flexible licensing options support different levels of complexity. Thus,
GMG offers an ideal solution exactly for your specific requirements. The main GMG ColorServer appli-
cation and all possible add-on programs available for GMG ColorServer are referred to as GMG Col-
orServer Suite in the documentation.

Note Some of the features described in the following are not included in the standard GMG ColorServer
version and require an additional license (GMG InkOptimizer, GMG SmartProfiler, GMG FlawFinder or
GMG ProfileEditor). Please contact your local dealer for details.

1.2.1 Main General Features

High-quality color management

Normalizing multiple color spaces

Automated color space conversions optimized for the target printing condition

RGB-to-CMYK separation

CMYK-to-CMYK conversion or reseparation

Spot colors can be converted to CMYK. Databases with DeviceLink spot color profiles for several
commercial providers such as PANTONE®, HKS, and DIC Color Guide® are included.

Create your own custom spot color databases with the expert tool GMG SpotColor Editor.

High-quality colors matching the original colors as intended by the creator of the document

High degree of reproducibility

Perfectly smooth gradients

Print deep, dark color tones to bring out detail in the shadows

Print bright and colorful images

Avoid unintended tints or color drifts

Browser-based remote access to all main functions (GMG WebConnect)

Supported print standards are:
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Offset (PSO)

Newspaper

PSR

GRACoL

SWOP

3DAP

JMPA

JPC

PPA

PDF Optimization for print production

Automated analysis of embedded ICC profiles and subsequent MX4 based color management

Flatten transparencies, layers, and overprinting in PDFs

Flattened and color managed output PDFs that can be directly sent to the printer or press

User-defined warning system that keeps you informed and helps you keeping everything under con-
trol

Control and connectivity with GMG WebConnect

GMG ColorServer comes with GMG WebConnect, a web interface which enables multiple users to access
the software and create jobs directly from any standard web browser and track them from anywhere in the
world.

Automated workflows with GMG ColorProof

If you want to also automatically proof your output PDFs, GMG ColorServer can team up with GMG Col-
orProof by using cascaded hotfolders. Simply link hotfolders from GMG ColorServer to a specific GMG Col-
orProof workflow. This way, you can set up integrated and completely automated workflows for all kind of
different applications and proofers.

1.2.2 Conventional Printing

This product variant was specifically designed with Offset and Gravure Printing in mind. In addition to the
general benefits of GMG ColorServer, it offers the following advantages.

Increase your production output

Save valuable ink and print media

Get to know the unique MX4 DeviceLink technology and by-pass the L*a*b* color space to prevent
contamination by other colors: 50% black stays 50% black.

Comes ready-to-use with profiles optimized for the target printing condition and tested by GMG Col-
orExperts.

The Hotfolder Creation Wizard guarantees a simple and fail-proof setup.

Create your own custom profiles with GMG ProfileEditor (optional).

Use effective ink saving strategies with GMG InkOptimizer

Use GMG InkOptimizer profiles for automated UCR/GCR conversions while at the same time increasing
the print quality and production stability. Using GMG InkOptimizer can save you up to 20% ink (depend-
ing on the printing process and on the used medium). To clearly see the benefits of this technology, you
can generate Ink Saving Reports which calculate your ink consumption and your potential savings.
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Cost reduction

Excellent and stable gray balance

Higher printing quality

Avoid overinking for an improved image quality and fail-proof production, especially for Newspaper
printing

1.2.3 GMG ColorServer Suite Workflow

GMG ColorServer Suite is a full-featured automated system ensuring an excellent print quality and pro-
duction stability in a conventional production environment.

With GMG WebConnect, which is included in GMG ColorServer Suite, you can set up client users for sub-
mitting jobs from a browser. Client users do not need to install GMG WebConnect and just need a stand-
ard web browser to access the web server and create and track jobs from anywhere in the world.

Workflow diagram illustrating the process chain.

No. Description

1 RGB and CMYK input data from multiple sources are collected for processing with GMG ColorServer.

2 You can easily submit jobs from any standard browser on any platform such as Windows or Mac OS.

3 Submitted jobs will be automatically uploaded to a web server running GMG WebConnect. The web server can be installed on
the same computer as GMG ColorServer or on a different computer, as shown in the above illustration. The web server will dis-
tribute incoming jobs to hotfolders on the GMG ColorServer system.

4 Input documents are converted to PDF and optimized for the target printer by GMG ColorServer.

5 Normalized CMYK data is then sent to a printer from the printer pool via the output folder.

GMG ColorServer

The central core module of GMG ColorServer processes input documents and performs high-quality color
management. The technology is hotfolder based: You only need to copy the document into a hotfolder—
the processing is started fully automatically. Output PDFs can be directly sent to the printer. GMG Col-
orServer will be installed on a central server so that hotfolders can be accessed from multiple work-
stations.

Files from different or unknown sources are normalized to a common color space according to the tar-
get printing condition ISO Coated v2 (39L) or GRACoL.

PDFs are flattened and optimized for achieving premium print results.

Colors are optimized specifically for the used printer–medium combination, that is, for a specific
printer and print medium, a specific ink type and print mode.

1.2.4 Software Components

The product GMG ColorServer comprises multiple components as described in the following.
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Note Some of the features described in the following are not included in the standard GMG ColorServer
version and require an additional license (GMG InkOptimizer, GMG SmartProfiler, GMG FlawFinder or
GMG ProfileEditor). Please contact your local dealer for details.

GMG ColorServer

Main program, for automated color space transformations of image data and PDFs with hotfolder tech-
nology.

GMG ProfileEditor

Expert tool for creating and editing MX4 profiles. Requires an additional license.

GMG GamutViewer

Analyzer tool for a visualization of gamut files (*.csc or *.txt) in a 2D or 3D view, integrated into GMG
ProfileEditor.

GMG SpotColor Editor

Expert tool for creating and editing spot color databases and gradation correction files.

1.2.5 ProgramOverview

Fig. 1 Main program window of GMG ColorServer.

The Overview window provides an overview on your hotfolder configuration (1). You can double-click a
hotfolder to show the processing settings. You can use a hotfolder command from the context menu. You
can select a hotfolder with the mouse to create a manual job. (The Printer configuration is important only
if you are using Image Hotfolders. Image Hotfolders require a ColorServer printer.)
On the right pane, you can see all jobs generated by the selected hotfolder (2). You can select a job and
use a job command from the context menu, for example, to manually start printing.
The Output Log window (3) shows a list with all processed jobs. (You can activate the Output Log window
from the Options menu.)

See also:

l "Hotfolder List View" on page 22
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1.3 Computer Configuration

1.3.1 System Requirements

Our recommendations and minimum system requirements are meant to provide general guidelines for run-
ning GMG ColorServer. We recommend systems that meet or exceed the following requirements.

Processor: Intel dual core CPU

Memory: 4 GB RAM, 250 GB hard disk drive

Hardware components: Video card (supporting DirectX 10), enabled Direct 3D acceleration, updated
driver (not Windows default driver), minimum resolution 1024 x 786 dpi, USB 2.0 port

Operating system:

Windows 8 (32-bit/64-bit version)

Windows 7 (32-bit/64-bit version)

Windows Server 2008 R2 SP1 (32-bit/64-bit version)

Software components:

Microsoft Internet Explorer 8.0 or higher

DirectX 10 or higher (required for the GMG GamutViewer feature in GMG ProfileEditor)

Maximum processing performance

For maximum processing performance, we recommend the following computer configuration.

Processing power: 4–8 CPU cores (2 GHz or higher)

Memory: fast HDD RAID with 6–8 GB RAM, SSD for temporary data

When using a RAID system, that is, combining separate hard disk drives into a system, we recommend to
divide the data transfer according to the following schemes.

Disk drive for GMG ColorServer + RAID 0 for hotfolders and temporary folder

Disk drive for GMG ColorServer and hotfolders + SSD for temporary folder

Disk drive for GMG ColorServer + RAID 0 for hotfolders + SSD for temporary folder

See also:

l "PDF Processing Performance"

l "Creating a Hotfolder Manually" on page 17

1.3.2 Recommended Hardware Configuration

For maximum processing performance, we recommend the following hardware configuration with three
separate disk drives on the same computer, as described in the following.

Note A noticeable performance increase can be achieved only with separate physical disk drives, not with
separate partitions on the same disk drive.

Disk drive with the GMG ColorServer installation

Disk drive for input data (Input Folders)

Disk drive for output data (Output Folders)

See also:

l "Creating a Hotfolder Manually" on page 17

1.3.3 Graphics Card Configuration for Gamut Viewer

For using the gamut viewer included in GMG ProfileEditor, you need to use a graphics card that supports
the required drivers and software components.
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Hardware recommendations: Graphics card supporting DirectX 10, with activated Direct3D acceleration,
with up-to-date driver (not Windows default driver)

How to check the DirectX settings

Open the Windows Control Panel and check that the video card driver provided by the manufacturer
of the video card is used. Check also that the driver is up to date.

Install DirectX 10 or higher.

In the Start/Run box of the Windows operating system, type in "dxdiag" and press Enter.
The DirectX Diagnostic Tool dialog box is displayed.

Click the Display 1 tabbed page.

Check that the following DirectX features are enabled: DirectDraw Acceleration, Direct3D Accel-
eration, and AGP Texture Acceleration. Enable them if this is not the case. If it is not possible to acti-
vate these features, the graphics card might not support them and you might need to use a different
card.

How to check the hardware acceleration settings

1. Open the Display Settings of the Windows operating system.

2. Open the Advanced Settings.

3. Click the Troubleshoot tab.

4. Click the Change Settings button.
(If your current display driver does not allow you to change the settings, you will see the Change Set-
tings button grayed out, and you will not be able to change the settings.)

5. Set Hardware Acceleration to Full.

1.4 Program Installation

1.4.1 Installation Overview

GMG ColorServer Suite comes with several components you can select in the feature list of the instal-
lation wizard. The following table will provide you with information on the different components followed
by a description of the possible client/server structures.

Feature/Component Description See also

ColorServer Main color management application.

ConnectManager GMG ConnectManager is a utility program that monitors all GMG Connect com-
ponents.

ConnectServer Part of the GMG Connect system that links GMG applications such as GMG Col-
orServer and GMG SmartProfiler or GMG WebConnect across different computers.
Central data management of the Connect system, needs to be run in the background.

Ink Saving Report Tool Tool that analyzes your output and calculates the ink savings you could realize with
GMG InkOptimizer.

"Creating an Ink
Saving Report"

SmartProfiler Calibration and profiling wizard. GMG SmartProfiler can also be installed as a client
component on a different computer for information exchange with GMG ColorServer
via your local network.

See GMG-Smart-
Profiler_Manual_
en.pdf

WebConnect Server Web server for remote data management that allows to set up users for remote use of
GMG ColorServer hotfolders.

"Installing and
Configuring the
Web Server"

"WebConnect"



GMG ColorServer Conventional Printing—Quick Start Guide

11 / 28

Feature/Component Description See also

ProfileEditor / Spot-
ColorEditor

Profiling and spot color editing tool. GMG-Pro-
fileEditor_CS_
Readme_en.pdf

Client/Server configuration possibilities

All components of GMG ColorServer Suite can either be installed on one system and used just locally or
distributed across several computers, allowing for a networked, but centrally controllable cross-platform
color management. For example, you can install GMG SmartProfiler on several computers within your net-
work and create hotfolders with color management files in GMG ColorServer via remote access. Web-
Connect also follows the client/server model, but as the client only needs a web browser to access GMG
ColorServer hotfolders, there is no installation required from the client side.

Client-server configuration: Installation on two separate computers (server, client), as shown in the
table below.

Workstation Installation

Server GMG ColorServer, GMG ConnectServer, GMG WebConnect

Client GMG SmartProfiler

Note The number of client programs you can install on different computers depends on the purchased
license. All client computers must have access to the server with Full Control permissions.

Note GMG SmartProfiler licenses are managed by GMG ConnectServer. You need to install GMG Con-
nectServer on the same computer as GMG ColorServer. Otherwise, it will not be possible to run the client
software.

1.4.2 Before You Install

To ensure a safe installation, please check the following list before starting the process.

Check the system requirements for the software you want to install.

Make sure a valid license required for the software version you want to install is available on the tar-
get computer.

Unplug all measuring devices connected to the computer (if any). Otherwise, device drivers will not
be properly installed.

Make sure you are logged on as a user with full administrator rights.

Make sure no Microsoft system updates are running in the background. This could lead to an instal-
lation failure.

1.4.3 Installing GMG ColorServer

Note The GMG ColorServer Suite installer offers an update functionality. If you have already installed
GMG ColorServer4.7 or later, you do not need to uninstall an existing version before installing the new
version. If you have installed an earlier version, you will need to uninstall an existing version before
installing the new version.

GMG ColorProof o4, DotProof o4, FlexoProof o4

If you have a dongle with a combined license for GMG ColorServer and GMG ColorProof o4, DotProof o4,
or FlexoProof o4, you will not be able to use proof printers anymore after installing the GMG ColorServer
4.7 setup. This functionality is only supported up to version 4.6.
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How to uninstall the previous version

Existing hotfolder configurations or application data from the user are not changed by the installer. Still, it
is recommended to make an environment backup to save all workflows and settings before uninstalling
the software to avoid any potential data loss.

1. Start your currently installed version of GMG ColorServer.

2. On the Options menu, point to Environment Backup, and click Create.

3. After the Environment Backup has been successfully created, close all GMG applications.

4. Uninstall GMG ColorServer from the Windows Control Panel (Start > Control Panel > Programs and
Features). Do not delete the main program folder (default folder for version 4.6 or lower: c:\C-
olorproof\) manually before the new installation as the folder contains all printer calibrations, pro-
files, and other system files and application data related to the software.

5. After the uninstall operation is complete, restart the computer.

How to install the new version

Note Even if the installer appears to be unresponsive, it is still working in the background. Do not cancel
the installation, end the process, or restart the computer until the installation is finished.

1. For a successful installation of device drivers, unplug all spectrophotometers connected to the com-
puter.

2. You can install the program directly from the purchased DVD.

3. If you downloaded the program from the GMG website, copy the ZIP file to a local directory on the
computer you want to install the program on.

4. Extract all compressed files and double-click the setup.exe file to start the installation.
(x86 to run the software on a 32-bit system and x64 for compatibility with a 64-bit system. Please
note that this only concerns the ability of the application to run on a 64-bit system, GMG ColorServer
as such remains unchanged.)

5. Follow the instructions of the installation assistant. (If upgrading from an earlier version than 4.7,
please install the program to a different folder than the one you installed the previous version to.)

6. Under Setup Type, you can select the Custom option if you want to install only the main components
required for a specific program.

7. Deselect the features you do not want to install on the computer.

8. If you want to run GMG SmartProfiler on a remote client and not on the same computer as GMG Col-
orServer, select only the Server features (i. e. GMG ColorServer, GMG ColorServer Connector, and
GMG ConnectServer) for the installation on the server computer and select only the Client features
(i. e. GMG SmartProfiler) for the installation on the client computer.

9. Please wait while the installer is running.
The installer needs to extract the installation package, install the program, and copy all application
data to the hard disk. These actions may take a while.

10. Restart the computer if you are prompted to do so.
The installation procedure will be automatically resumed after the restart.

11. The installation assistant will inform you when the installation is complete. Click the Finish button to
exit the wizard.

1.5 Starting GMG ColorServer

Note Make sure the license dongle is connected to a USB port.
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How to start GMG ColorServer

1. Double-click the GMG ColorServer program icon on the Windows desktop or click GMG ColorServer
on the Windows Start menu.
The program verifies the license information on the dongle and then starts the application auto-
matically.

2. Optional: If you had a previous version of GMG ColorServer installed and have an environment
backup, you can restore it now. On the Options menu, point to Environment Backup, and click
Restore.
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2. First Program Start
If you start GMG ColorServer for the first time, the main window (named Overview) is empty. This is
because no printers and hotfolders have been configured yet. If you had a previous version installed, your
existing hotfolders and installed printers will show up automatically.

Fig. 2 Main program window with empty hotfolder list after first start.

You can create a new hotfolder now. Even if you want to create a manual job, you will first need to create
at least one hotfolder as a kind of template for the manual job.

2.1 License Information

All available features are controlled by the license information on the connected USB dongle. Please
make sure that you have all licenses required for the actions you want to perform with the software.

For example, trial or temporary program versions can be limited either by the number of actions the user
can perform or by an expiration time.

Licenses can be updated via the software. For more information on available license packages, please con-
tact your local dealer.

Please keep the license information and serial number at hand when contacting the support.

How to check the currently available licenses

1. Start the main GMG ColorServer application.

2. On the Help menu, click Update License.
A list with all licenses installed on the connected USB dongle is displayed.

2.2 Administrator Mode

In GMG ColorServer, users can set up hotfolders or change hotfolder settings only in Administrator Mode.
This way, unintended changes can be easily avoided. This is especially useful if different teams have
access to the same computer. You can secure the administrator mode by using a password.

Note We recommend setting up a password directly after program installation. If no password is set up at
the beginning, any user can enter the Administrator Mode and set up a password, thus locking the program
settings for all other users.

Note If you uninstall GMG ColorServer, the password information is not deleted from the registry. The pass-
word protection (using the old password) will still apply when reinstalling the program later.



GMG ColorServer Conventional Printing—Quick Start Guide

15 / 28

How to set up or change the password 

1. On the Options menu, click Administrator Password.
The Change Password dialog box is displayed.

2. Type the appropriate password (if required) into the Old Password box. Type the new password into
the New Password and Confirm Password boxes.

How to switch operating modes

1. On the Options menu, click Administrator Mode.
If a password has been set up, a dialog box is displayed asking you for the password. If no pass word
has been set up, the operating mode is switched to Administrator Mode at once.

2. Enter the appropriate password (if required).
You can now set up or change workflows.
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3. About Hotfolders

Hotfolders are generally used whenever a larger number of files need to be converted according to the
same rules and output settings. Setting up hotfolders also leads to a higher degree of consistency and repro-
ducibility. You can assign any number of input folders to a single hotfolder.

All processing parameters such as color management and output parameters are defined in the hotfolder.

It is possible to set up various hotfolders according to different input data or to different print standards.

Information on all files currently present in a hotfolder is shown in the info pane on the right side of the
main window. The info pane also shows which hotfolder is currently processing which input files.

3.1 Hotfolder Types

GMG ColorServer offers two different types of hotfolders: Image Hotfolders and PDF Hotfolders. As the
name indicates, Image Hotfolders are basically used to color-convert images or to convert the image file
format (e.g. from TIFF to JPEG). PDF Hotfolders, on the other hand, allow for far more functionalities and
can be used to process both images and PDFs, automatically converting images to PDF format.

Image-to-PDF and PDF-to-PDF Conversion

Processing PDF documents demands extended functionalities due to the fact that PDFs can contain a mix
of images and vector-based objects in multiple color spaces. Usually, each PDF object is tagged with an
ICC profile that describes the color space of the object. GMG ColorServer automatically identifies these
profiles and uses them as a starting point for the subsequent color management.

Image-to-PDF Conversion: All supported document formats (TIFF, JPEG) are converted to PDF.

PDF-to-PDF Conversion: For native PDF documents. You can choose to apply CMYK-to-CMYK con-
version profiles or ink optimization profiles (GMG InkOptimizer).

3.2 Creating a New PDF Hotfolder

Note Some of the features described in the following are not included in the standard GMG ColorServer
version and require an additional license (GMG InkOptimizer, GMG SmartProfiler, GMG FlawFinder or
GMG ProfileEditor). Please contact your local dealer for details.

Reflecting the different needs of our customers, PDF Hotfolders can be created in different ways in GMG
ColorServer.

The quick and very easy way to create hotfolders is to use our Hotfolder Creation Wizard. As hotfolders
created by the wizard already contain presets for all major printing conditions, you only need to select
very basic parameters such as the target color space.

If you need custom settings or want to define all settings yourself, you can also create a new hotfolder
from scratch, ranging from the very simple to the highly complex.

See also:

l "Creating a Hotfolder Manually" on page 17

l "Creating a Hotfolder with the Hotfolder Wizard" on page 16

3.2.1 Creating a Hotfolder with the Hotfolder Wizard

The quickest and easiest way to create a PDF hotfolder for conventional printing processes is to use the
Hotfolder Creation Wizard, which can be started from the Hotfolder menu.

Every step you are going through is explained in detail and will not require any extra knowledge. As soon
as you created a new hotfolder, it will show up in the Hotfolder List View on the left side of the main win-
dow.
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3.2.2 Creating a Hotfolder Manually

Note Hotfolders can be added, modified, or deleted only in Administrator Mode (Options menu > Admin-
istrator Mode).

When setting up a hotfolder from scratch, you first need to define input folder(s) for the input files and an
output folder for the processed files.

How to manually set up a hotfolder

1. On the Hotfolder menu, click New PDF Hotfolder.
The PDF Hotfolder dialog box opens.

2. Click the Files & Folders button on the navigation panel on the left side of the dialog box.

3. Click the Input Folders tab.

4. Type any name into the Hotfolder Name box.

5. On top of the Input Folders list, click the Add Input Folder button .

6. Browse to the desired folder, or create a new folder, and confirm by clicking OK.
The selected folder is added to the Input Folders list.

7. Optional: If you want to assign multiple input folders to the same hotfolder, repeat steps 5 and 6.

8. Optional: You can delete hotfolders by clicking the Remove Input Folder button .

9. Optional: If you want to convert image file formats to PDF, select the option Convert TIFF and JPEG
to PDF.

Fig. 3 Hotfolder Input settings.

Defining an Output Method

You can send the processed PDF files to an output folder or to a Windows printer connected to a real
printer. If you decide for the print option, the PDFs are saved temporarily and then directly send to the
printer, using the defined printer properties.

How to set up a Windows printer

Note The output PDF files are stored to a temporary folder (File menu > General Settings: Temporary
Folder) until the associated jobs are removed from the job list.
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1. On the navigation panel of the PDF Hotfolder dialog box, click Files & Folders.

2. Click the Output Files tabbed page.

3. Under Output Method, select Send to Windows Printer.

4. Under Name, select the printer you want to output your files to.

5. Optional: Click the Properties button to open and edit the printer properties.

Fig. 4 Output to a Windows printer.

How to set up an output folder

Tip If you want to use PDF and Image Hotfolders, you can set up two separate input folders, but a common
output folder. This makes it very easy to use GMG ColorServer output folders as input folders for your work-
flow system, printer, or press.

1. On the navigation panel of the PDF Hotfolder dialog box, click Files & Folders.

2. Click the Output Files tabbed page.

3. Under Output Method, select Hotfolder.

4. Under Output Folder, click the browse button on the right side of the edit box.

5. Browse to the desired folder, or create a new folder, and confirm by clicking OK.

6. Select the option Keep File Name of Input File and enter a Suffix or Prefix so that you can easily dis-
tinguish between the input and processed output files.
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Fig. 5 Output to an output folder.

PDF Hotfolder Basics

This chapter will give you a quick overview on main hotfolder settings, without going into much detail.
Please see the GMG ColorServer Help for further information.

Folder Structure

1. Double-click a hotfolder to open the PDF Hotfolder dialog box.

2. On the navigation panel of the PDF Hotfolder dialog box, click Files & Folders.

The Input Folders page shows the Input Folders, into which you will copy all files that you want to process
with the hotfolder.

Processed PDFs that do not generate a warning will be saved to the Output Folder defined on the Output
Files page.

PDFs that generate a warning or unprocessed PDFs are sent to the Warning and Error folders defined on
the Errors & Warnings page.

Reports are saved to the Reports folder defined on the Reports page.

Flattening settings

1. On the navigation panel of the PDF Hotfolder dialog box, click Flattening & Normalizing.

2. Click Flattening.
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Fig. 6 Hotfolder using flattening.

The hotfolder shown in the screenshot uses flattening. You can select Process without Flattening from the
drop-down list to switch off flattening.

Normalizing output color space

1. On the navigation panel of the PDF Hotfolder dialog box, click Flattening & Normalizing.

2. Click Images.
The most important parameter on this page is the Output ICC Profile, which defines the Normalizing
color space.

Fig. 7 Output color space of the Normalizing step.

All PDF objects in the input color spaces selected on the Images and Vector & Text tabbed pages will be
normalized to the color space defined by the Output ICC Profile.

MX4 based normalizing

1. On the navigation panel of the PDF Hotfolder dialog box, click Flattening & Normalizing.

2. Click MX4 Normalizing.
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Fig. 8 Hotfolder using MX4 Normalizing.

The hotfolder uses MX4 Normalizing. This means that instead of ICC profiles, MX4 DeviceLink profiles are
used for normalizing. The program automatically selects the correct conversion profile with respect to the
embedded ICC profile of the PDF object and the Output ICC Profile defined on the Images and Vector &
Text tabbed pages.
You can deselect the option Use MX4 DeviceLink Profile instead of ICC Profiles if you want to use only
ICC profiles for flattening (not recommended).

MX Color Processing (main color management step)

On the navigation panel of the PDF Hotfolder dialog box, click MX Color Processing.

Fig. 9 CMYK-to-CMYK conversion.

The color space conversion and the TAC limitation is defined by the ColorServer conversion profile
selected in the MX Profile for Images (and Vector/Text) box.
The hotfolder applies a CMYK-to-CMYK conversion from the ISO Coated v2 (39L) print standard to ISO
Web-Coated (28L), including a limitation of the TAC to 300%.
If you want to use another conversion or reseparation type, you can simply select another profile.
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3.3 Hotfolder List View

Selecting a hotfolder

A hotfolder can be selected in the list with the mouse or by pressing the ARROW UP or DOWN key. A
selected hotfolder or workflow is highlighted by a different border and background color.

When a hotfolder from the left window frame is marked by using the mouse, the window on the right will
show the dedicated images or PDF jobs. Selecting such an image, the lower window will display the asso-
ciated job. Selecting the PDF job, the lower window displays the associated PDF document properties.

Hotfolder commands 

Hotfolder commands such as editing or creating a manual job can be selected from the Hotfolder menu or
from the context menu (which appears when you right-click on a hotfolder) and are applied to the selected
item.

The command Hold Images, which may be selected from the context menu by right-clicking on a hot-
folder, puts the automatic processing of jobs by the hotfolder on hold. New files will still be recognized in
the hotfolder and will be added to the file list in the hotfolder. These new documents will remain in status
Hold Images until the command Hold Images is switched off again by the user.

Fig. 10 Hotfolder put on hold.

As you can see in the screen shot, jobs have been created from all PDFs recognized by the hotfolder. Jobs
are in status on hold as long as the hotfolder is on hold (indicated by the blue Hold icon). After activating
the hotfolder, you need to manually start the processing of each job by using the Print command.

Job commands

Right-clicking on an image or PDF job opens the context menu. There you are able to Print or Delete an
image or PDF job, or to show a Preview.
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Fig. 11 Start processing a job on hold.

On the job context menu, click Print to start the processing of jobs on hold.

3.4 Creating a Manual PDF Job

After you have set up a PDF hotfolder, you can now also create manual jobs. This is convenient if you
want to process only a few documents with slightly different settings than defined in the hotfolder. Still, as
the hotfolder settings are used as a kind of template for manual jobs, you will only need to fill in a few
parameters.

How to create a manual job

1. From the Overview, select a hotfolder as a template for the manual job.

2. Right-click the hotfolder to open the context menu.

3. Click New PDF Job.
The PDF Manual Job dialog box opens.

4. Click the Files & Folders button on the navigation panel on the left side of the dialog box.

5. Click the Input Files tab.

6. Type any name into the Job Name box.

7. On top of the Files list, click the Add File button .

8. Browse your folders, select the desired input files, and confirm by clicking OK.
The selected PDFs are added to the Files list.

9. You can remove files from the list by clicking the Remove File button .
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Fig. 12 Creating a manual PDF job as described in the preceding instructions.
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4. Profile Types

Note Some of the features described in the following are not included in the standard GMG ColorServer
version and require an additional license (GMG InkOptimizer, GMG SmartProfiler, GMG FlawFinder or
GMG ProfileEditor). Please contact your local dealer for details.

Type Usage Where to find See also

CMYK-to-CMYK
Conversion

Used in the MX Processing step, for conventional printing. Used for nor-
malizing colors in the Normalizing step. For color conversions of CMYK
objects from one standard to another, including a gamut mapping, for
example, from ISO coated to ISO uncoated.

reference pro-
files\ColorServer Pro-
files\CMYK
Conversion Profiles\

"CMYK-to-
CMYK Con-
version" on
page 25

CMYK-to-
CMYK Reseparation

Used in the MX Processing step, for conventional printing. For har-
monizing GCR/UCR for different output processes under the respective
printing conditions (without using an InkOptimizer profile).

reference pro-
files\ColorServer Pro-
files\Reseparation
Profiles\

"CMYK-to-
CMYK Resep-
aration" on
page 26

RGB-to-CMYK Sep-
aration

Used in the MX Processing step, for conventional printing. Used for nor-
malizing colors in the Normalizing step. For transformations of RGB
objects into CMYK.

reference pro-
files\ColorServer Pro-
files\Separation
Profiles\

"RGB-to-
CMYK Sep-
aration" on
page 26

RGB-to-RGB Con-
version

Used in the MX Processing step, for conventional printing. For trans-
formations of RGB objects from one standard RGB color space to
another, for example, from Adobe RGB (1998) to eciRGB v2.

reference pro-
files\ColorServer Pro-
files\RGB Conversion
Profiles\

"RGB-to-RGB
Conversion"
on page 26

InkOptimizer Used in the MX Processing step. Optimized GCR/UCR settings, available
in three different levels (G3, G2, G1).

reference pro-
files\InkOptimizer
Profiles\

"InkOptimizer
Profiles" on
page 26

CMYK-to-RGB Con-
version

Used in Image Hotfolders, as Additional Profile, for transformations of
CMYK objects into RGB.

reference pro-
files\ColorServer Pro-
files\CMYK-RGB
Conversion Profiles\

"CMYK-to-
RGB Con-
version" on
page 26

GMG Color GmbH & Co. KG provides MX4 profiles and spot color databases (db3) for all major print stand-
ards world-wide. All GMG color profiles were created and tested by GMG ColorExperts.

To suit different use cases, GMG ColorServer provides you with different types of color profiles (MX4
DeviceLink profiles). MX4 profiles installed with the setup can be found in the reference profiles subfolder
of the main program folder (default path: <installation path>\reference profiles\). The folder names cor-
respond to the basic color conversions as described in the preceding table.

Not all GMG ColorServer profiles are installed with the setup. The PDF document ColorServer Profiles.pdf
located in the software directory in the /reference profiles/ColorServer Profiles/ folder gives an overview of
the installed profiles.

You can always find the latest profiles on the GMG website, in the Support section.

www.gmgcolor.com

4.1 CMYK-to-CMYK Conversion

A CMYK-to-CMYK conversion means an automated color conversion from a print standard such as PSR,
ISO, GRACoL, and 3DAP to another print or in-house standard. Outgoing data will be optimized for dif-
ferent output processes (for example, for offset or gravure printing) with the respective printing conditions.

As GMG ColorServer uses four-dimensional MX4 DeviceLink profiles, the source and target values are
computed directly in CMYK—without using CIELab as an intermediate color space. The black channel sep-
aration from the original data is preserved when transforming into the target CMYK color space, main-
taining the visual impression of the document.

http://www.gmgcolor.com/english/support.html
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4.2 CMYK-to-CMYK Reseparation

A CMYK-to-CMYK reseparation means an automated reseparation of CMYK data prepared for one print
standard. This is suitable for a harmonization of files having different UCR/GCR settings to achieve a con-
sistent color channel separation. Standardized separations help to establish a stable print result.

4.3 RGB-to-CMYK Separation

The increasing use of digital cameras and RGB-based workflows is driving more and more RGB data use.
However, the RGB data supplied is often in a not finalized status, meaning the resolution of image data
has still to be scaled to the final size and to be sharpened in accordance with the changed resolution. The
data is then subsequently separated into the CMYK color space required for printing.

The hotfolder technology used in GMG ColorServer automates all required steps. Image data placed into a
hotfolder can be scaled, sharpened, and separated in accordance with the parameters assigned to the hot-
folder. This automatic process makes a manual editing in an image editor obsolete.

Separation profiles delivered together with the program use special UCR settings and algorithms for a more
effective gamut mapping. An effective gamut mapping is required for minimizing visual changes when
reducing the larger RGB color space to the smaller CMYK color space.

4.4 RGB-to-RGB Conversion

A RGB-to-RGB conversion means an automated color conversion of RGB data from one standard RGB
color space into another standard RGB color space such as Adobe RGB (1998), sRGB, and eciRGB.

This conversion is particularly useful for standardizing RGB data in the prepress business. A conversion
with MX4 RGB-to-RGB conversion profiles leads to a smooth gamut boundary.

4.5 CMYK-to-RGB Conversion

Note CMYK-to-RGB conversions are applied in Image Hotfolders because they are primarily (if not exclu-
sively) applied to images. They are not supported for PDF-Hotfolders.

A CMYK-to-RGB conversion means an automated color conversion from a print standard such as ISO or
GRACoL to a print process neutral AdobeRGB color space. This conversion is particularly useful for nor-
malizing CMYK images in different color spaces to a common color space.

Supported input and output color spaces

Profile type Input color space Output color space

CMYK-to-RGB ISO coated v2 (39L)

GRACoL2006 Coated Commercial Sheet (#1)

SWOP Publication Sheet (#3)

SWOP Groundwood (#5)

AdobeRGB

Tip Further profiles for other input and output color spaces are available on the GMG website and inte-
grated in the GMG ColorMaster workflow package.

4.6 InkOptimizer Profiles

InkOptimizer profiles (*.mx4) are four-dimensional device-link profiles for CMYK-to-CMYK reseparation
and UCR/GCR optimization.

They reseparate the incoming data, applying GMG’s specialized GCR settings as defined within each pro-
file. Using InkOptimizer profiles will reduce the application of the CMY inks and increase the K ink in
their place. Intelligent algorithms allow this change without visible effects on the four color printed
results.
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GMG InkOptimizer profiles are tamper-proof with an embedded CRC control code and write protection.

Generally, the GMG InkOptimizer product includes, next to the installation CD, GMG InkOptimizer pro-
files G1, G2, and G3, which employ different optimization levels.

Profiles of the G1 type use the highest possible GCR level. The G2 level uses medium optimization, and
G3 profiles use the lowest optimization level, thus leading to the lowest ink reduction.
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5. Where to Find Further Information
For further information on how to use the software and adapt it to your needs, please consult the Help (F1)
from within GMG ColorServer.

You will always find the latest versions of user manuals on the GMG website.

www.gmgcolor.com > SupportArea

Further information:

l GMG ColorServer User Manual:
GMG-ColorServer_PDF-to-PDF_Manual_en.pdf
GMG-ColorServer_PDF-to-PDF_Manual_de.pdf

l Creating new MX4 ColorServer profiles in GMG ProfileEditor:
GMG-ColorServer_Tutorial_MX4_en.pdf
GMG-ColorServer_Tutorial_MX4_de.pdf

http://www.gmgcolor.com/english/support.html
http://www.gmgcolor.com/english/support.html
http://www.gmgcolor.com/english/support.html
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